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    Chapter 7   

 Monitoring Mitochondrial Membranes Permeability 
in Live Neurons and Mitochondrial Swelling 
Through Electron Microscopy Analysis 

           Macarena     S.     Arrázola     and     Nibaldo     C.     Inestrosa    

    Abstract 

   Maintenance of  mitochondrial    membrane   integrity is essential for mitochondrial function and neuronal 
 viability  .  Apoptotic    stimulus   or  calcium overload   leads to mitochondrial  permeability   transition  pore   
( mPTP  ) opening and induces mitochondrial   swelling   , a common feature of mitochondrial  membrane   per-
meabilization. The fi rst phenomenon can be evaluated in cells loaded with the dye  calcein  -AM quenched 
by  cobalt  , and mitochondrial  swelling  can be detected by  electron microscopy   through the analysis of 
mitochondrial membrane integrity. Here, we describe a  live cell imaging   assay to detect mitochondrial 
permeability transition and the development of a detailed analysis of morphological and ultrastructural 
changes that  mitochondria   undergo during this process.  
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1      Introduction 

  Mitochondria   are membrane-enclosed  organelles   present in all 
cellular types, including  neurons  , where they participate in several 
vital processes, such as cellular bioenergetics, metabolism, and 
 calcium homeostasis   [ 1 ,  2 ].  Calcium   regulation is essential for the 
synaptic function of a  neuron   [ 3 ] and therefore for its  viability   
[ 4 ]. Calcium ions influx into neurons is regulated by different 
cellular compartments, including the  endoplasmic reticulum   and 
 mitochondria   [ 5 ].  Calcium overload   into mitochondria has been 
described as an inductor of the  mitochondrial    permeability   
transition [ 6 ], which is a phenomenon characterized by the 
formation of large  conductance   permeability transition pores 
( mPTP  ) that make the  mitochondrial membrane   abruptly 
permeable to solutes up to 1,500 Da, resulting in the loss of 
mitochondrial  membrane    potential   [ 7 ]. The permeabilization of 
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the mitochondrial inner membrane induces morphological 
changes in this organelle, including increased volume, a pheno-
menon known as  swelling  , membrane disruption,  cristae   dis-
organization, and the release of  pro-apoptotic   factors to the 
 cytoplasm  , to finally activate neuronal  death cascades   [ 8 ,  9 ]. For 
this reason, the maintenance of the structural integrity and 
function of mitochondria is crucial for their proper function and, 
therefore, for neuronal viability. 

 Mitochondrial  swelling   can be detected in vitro with a  spectro-
photometric assay   from isolated  mitochondria  , as previously 
described [ 10 ]; however, the amount of material required to obtain 
high quality purifi cation is a limiting step when the experimental 
model in use is a  primary culture   of  neurons  . For this reason, we 
describe here a direct  live cell imaging   technique to monitor the 
 mPTP   opening, and the development of a detailed data analysis. 
This assay was developed by Petronilli et al. in 1998 [ 11 ] and, 
later, was validated in a neuronal model [ 12 ]. The assay is based on 
the loading of living neurons with a  calcein  - AM  / cobalt   mix to 
quench the cytosolic signal of calcein, but leaving intact the  mito-
chondrial   stain. The exposure of neurons to mPTP inductors, such 
as the ionophore  ionomycin   [ 13 ], or to  calcium overload   results in 
the  decay   of the mitochondrial calcein  fl uorescence  , indicating 
mitochondrial  permeability   transition. Mitochondrial swelling can 
be also detected through the study of certain ultrastructural param-
eters by transmission  electron microscopy   [ 14 ]. We describe here a 
detailed analysis to evaluate morphological changes in mitochon-
dria exposed to permeability transition.  

2    Materials 

      1.    Glass  coverslips   of 25 mm  diameter   (Marienfeld GmbH & Co. 
KG, Lauda-Königshofen, Germany).   

   2.    1×  Neurobasal Medium   (Gibco ® , Life Technologies™, 
Carlsbad, CA).   

   3.     B27    supplement   (Gibco ® , Life Technologies™).   
   4.     DMSO   (Sigma Chemicals, St. Louis, MO).   
   5.    Stock probes: 1 mM  Calcein-AM  , 10 μM  MitoTracker    Orange   

CMTMRos, and 1 mM  Hoechst    33342   (all from Molecular 
Probes ® , Life Technologies™, Carlsbad, CA) in  DMSO  . Store 
at −20 °C protected from light.   

   6.    1 mM  Cobalt   (II) chloride hexahydrate (CoCl 2  × 6H 2 O)  stock 
solution  : To prepare 5 mL dissolve 1.1897 g in 5 mL of sterile 
distilled water. Store at −20 °C protected from light.   

   7.     Tyrode buffer  : 135 mM NaCl, 5 mM KCl, 1.8 mM CaCl 2 , 
1 mM MgCl 2 , 10 mM  HEPES  , 5.6 mM  glucose  , pH to 7.3 
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with concentrated HCl. To prepare 0.5 L weigh 3.944 g NaCl, 
0.186 g KCl, 0.132 g CaCl 2 , 1.19 g HEPES, and 0.280 g glu-
cose and transfer to a 0.5 L glass beaker containing 300 mL 
distilled water. Mix and then add 500 μL 1 M MgCl 2 . Adjust 
pH with HCl and make up to 0.5 L. Make aliquots of 50 mL 
in  Falcon tubes   or glass bottles and store at −20 °C. Defrost 1 
aliquot of Tyrode buffer for the assay, use it along the day and 
then discard. For calcium free experiments do not add CaCl 2  
to the preparation.  See   Note 1 .   

   8.    Confocal  microscope   with appropriate laser sources (see below).      

      1.    Cold artifi cial cerebrospinal fl uid ( ACSF  ): 124 mM NaCl, 
2.69 mM KCl, 1.25 mM KH 2 PO 4 , 1.3 mM MgSO 4 , 2.6 mM 
NaHCO 3 , 10 mM  glucose  , 2.5 mM CaCl 2 . To prepare a 10× 
 stock solution   of ACSF, weigh 72.466 g NaCl, 2.006 g KCl, 
1.701 g KH 2 PO 4 , 1.565 g MgSO 4  or 3.203 g MgSO 4  × 7H 2 O, 
21.843 g NaHCO 3 , and 19.817 g glucose. Mix and make up 
to 1 L. To prepare 1× ACSF solution, dilute 100 mL of the 
10× stock solution in 900 mL of distilled water. Oxygenate the 
solution by bubbling with an O 2 /CO 2  mix for 10 min and 
adjust pH to 7.4 with NaOH/HCl 1 N. Add 0.368 g 
CaCl 2  × 2H 2 O and make up to 1 L. Check again the pH and if 
it is necessary readjust to 7.4.   

   2.    Cell strainer 70 μm nylon (BD Biosciences, Bedford, MA).   
   3.    6-well plates for cell culture.   
   4.    Silicone tubes.   
   5.    0.1 M  cacodylate buffer  , pH 7.2 with HCl: Dissolve 2.14 g of 

sodium cacodylate in 80 mL of distilled water. Adjust pH to 
7.2 and then make up to 100 mL with distilled water.   

   6.    Fixative solution: 2.5 %  glutaraldehyde   (e.g., Sigma Chemicals): 
Dilute 1 mL of 25 % glutaraldehyde  stock solution   into 9 mL 
of 0.1 M  cacodylate buffer  , pH 7.2.   

   7.    1 %  osmium tetroxide   (OsO 4 ): Dilute 25 mL of a 4 % osmium 
tetroxide  stock solution   (Sigma Chemicals) with 75 mL of dis-
tilled water. Store at 4 °C.   

   8.    1 %  uranyl acetate   [UO 2  (OCOCH 3 ) 2  × 2H 2 O]: Weigh 10 mg 
uranyl acetate and dissolve in 1 mL distilled water.   

   9.     Epon   resin (e.g., EMbed-812, Electron Microscopy Sciences, 
Hatfi eld, PA).   

   10.    4 %  uranyl acetate   [UO 2  (OCOCH 3 ) 2  × 2H 2 O]: Weigh 0.4 g of 
uranyl acetate and dissolve in 10 mL pure  methanol  .   

   11.     Lead citrate   staining solution: mix 1.33 g Pb(NO 3 ) 2 , 1.76 g 
Na 3 (C 6 H 5 O 7 ) × 2H 2 O and 30 mL distilled water in a 50 mL 
volumetric fl ask. Shake vigorously for 1 min and allow  standing 
with intermittent shaking. After 30 min add 8.0 mL 1 N 
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NaOH and make up to 50 mL with distilled water. Mix until 
 lead citrate   dissolves. The fi nal pH is 12.0.   

   12.     Cooper grids   for  electron microscopy   (e.g., Ted Pella Inc., 
Redding, CA).   

   13.     Biosafety cabinet  .   
   14.    CO 2   incubator  .   
   15.     Vibrating microtome  .   
   16.     Ultramicrotome  .   
   17.     Transmission electron microscope  .       

3    Methods 

 For  live cell imaging  , all procedures are carried out at 37 °C and 
under sterilized conditions unless otherwise specifi ed. 

      1.    Seed  neurons   on glass  coverslips   of 25 mm  diameter   in a 
35 mm  dish   or in the available format ( see   Note 2 ). Neurons 
are maintained in  Neurobasal medium   supplemented with  B27   
at 37 °C in an  incubator   with 5 % CO 2 .   

   2.    For  live cell imaging  , load the cells with the  fl uorescent probes   
( see   Note 3 ). In this step work with the cells in a  biosafety cabi-
net   protected from light. Before removing the cells from the 
 incubator  , prepare the  loading mix  : add 1 μL of 1 mM  calcein  -
AM  stock solution  , 1 μL of 1 M CoCl 2 , and 5 μL of 10 μM 
 MitoTracker    Orange   in 993 μL of  Neurobasal medium   to 
make 1 mL. Final mix concentration is 1 μM  calcein-AM  , 
1 mM CoCl 2 , 50 nM MitoTracker Orange ( see   Note 4 ). 
 Hoechst   dye can also be added to the loading mix to evaluate 
neuronal  viability   if necessary.  See   Note 5 .   

   3.    Wash cells twice with 1 mL  Neurobasal medium   without sup-
plements ( see   Note 6 ). For 25 mm covers add 1 mL of  loading 
mix   to the  dish   and incubate  neurons   at 37 °C for 30 min, 
protected from light.   

   4.    Remove the loaded  neurons   from the  incubator   and wash 
twice with 1 mL of  Neurobasal medium  , working in a  biosafety 
cabinet  . Change medium to  Tyrode buffer   and incubate cells 
for 10 min at 37 °C to equilibrate probes.   

   5.    Transfer the cover to the  microscope   room and assemble the 
system as shown in Fig.  1a, b . Use little amounts of solid  paraf-
fi n   between both sides of the cover to fi x it at the microscope 
system.  See   Note 7 .    

   6.    Set  microscope   parameters to start the  mPTP    live cell assay  . 
For a  spinning disk   confocal microscope, use Texas Red fi lter 
to detect  MitoTracker    fl uorescence  ,  FITC   for  calcein  -AM, and 
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 UV fi lter   for  Hoechst  , or set the adequate  excitation  / emission   
wavelengths depending on the  microscope used ( see   Note 8 ). 
 Water immersion objectives   are recommended for  live cell 
imaging   assays. Set temperature to 37 °C and the gas pressure 
to ensure a constant fl ux of 5 % CO 2  in the  culture chamber   of 
the microscope.   

   7.    Set the time of the experiment and the interval between  digital 
images  . It is recommened to measure  fl uorescence   changes for 
15 min at least, with an image acquisition time of 10–15 s 
between  frames  . Measure a  baseline   for 3 min and then add the 
 stimulus   (Fig.  1c ) ( see   Note 9 ). Finally, check the  focus   and start 
the experiment. It is recommended to perform positive and neg-
ative controls of the  mitochondrial    permeability   transition  pore   
opening to check the effi ciency of the assay.  See   Note 10 .   

   8.    For image analysis use the NIH  ImageJ software   and install the 
“ Delta F  ”  plugin  . Follow the sequential steps to analyze  fl uo-
rescence   changes on the images: Open the image with Image 
J > Image >  Stacks   >  Z project  , type the number of images 
 corresponding to the basal line, i.e., a 3-min  baseline   corre-
sponds to 180 s, if images were taken every 15 s, and then the 

  Fig. 1    Sample assembly for live cell imaging assay. ( a ) Microscope system equipped for live cell assays. ( b ) 
Neurons seeded on a glass coverslip mounted in the microscope chamber with CO 2  and temperature regula-
tion. The glass cap is used to maintain the gas pressure and the temperature at 37 °C. ( c ) Closed chamber 
ready to use and for the stimulation of neurons. ( d ) Graphical representation of a common record obtained 
along the experiment after mPTP induction, i.e., with ionomycin. Mitochondrial calcein fl uorescence decay is 
usually observed under mitochondrial permeability transition conditions       
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fi rst 12 images correspond to the baseline; so type 1 in the start 
slice box and 12 in the stop slice > OK. This step creates an 
average image of the baseline.   

   9.    Run “ Delta F  ”  plugin   to determine  fl uorescence   changes from 
the image stacks: Plugins > Stacks>T-functions > Delta F. A new 
image called “Delta F” is generated from this step. To obtain 
the value of ΔF/Fo (variation of the fl uorescence between 
each image compared to the  baseline  ) follow the next steps on 
Image J: Process > Image calculator, on Image 1 select the 
Delta F image created in the previous step; operation: Divide; 
and Image 2 is the average image created fi rst > Yes. A new 
image is created called “Result of Delta F”. From this image 
select a  neurite   with the  polygon selection tool   and perform 
the analysis: Images > Stacks > Plot  z -axis Profi le. A “Results” 
window is displayed with the mean fl uorescence values corre-
sponding to each time point. Plot the data to obtain fl uores-
cence changes along the  live cell imaging   assay, as shown 
Fig.  1d . Repeat this step with each neurite selected until 
 complete around 8–10 neurites per  neuron  .   

   10.    Fluorescence analysis can be done with the  mitochondrial   
  calcein   images to detect  mPTP   opening and also with those 
obtained from the  MitoTracker   loading, to detect  mitochon-
drial membrane    potential   changes in response to the same 
 stimulus   (Fig.  2 ).       

      1.    Prepare  brain slices   from rat or mouse brain [ 15 ,  16 ]. Cut 
transverse slices of 400 μm under cold  ACSF   using a  vibrating 
microtome  .   

   2.    Incubate the slices in oxygenated  ACSF   for more than 1 h at 
room temperature before treatment.   

   3.    For slices treatment, mount the slices in a 6-well plate modifi ed 
as shown in Fig.  3 , to keep each  dish   oxygenated ( see  
 Note 11 ). Dilute all treatments in  ACSF   in an appropriate 
volume to maintain slices immersed and avoid its contact with 
the air. This step is carried out at room temperature.    

   4.    After treatment, transfer the slices one by one, with a soft 
brush or tweezers, to an Eppendorf tube containing 1 mL of 
the fi xative and fi x for 6 h.  See   Note 12 .   

   5.    After fi xation, wash the slices with 1 mL of 0.1 M  cacodylate 
buffer  , pH 7.2 for 18 h at 4 °C.   

   6.    Perform a secondary fi xation with 1 %  osmium tetroxide   for 
90 min and then wash with three washes, 5 min each in dis-
tilled water.   

   7.    Stain samples with 1 % aqueous  uranyl acetate   for 60 min.   
   8.    Dehydrate samples in  acetone   following these sequential steps: 

1 × 50 %, 1 × 70 %, 2 × 95 %, and 3 × 100 % acetone, 20 min each.   
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   9.    Place samples in 1:1  Epon  : acetone   overnight and embed them 
in 100 % Epon resin into a  mold  . Place mold containing sam-
ples in 60 °C oven for 24 h to polymerize.   

   10.    Cut ultrathin  sections   (60–70 nm) with an  ultramicrotome   
and collect them on 300-mesh copper  electron microscopy   
grids (Fig.  3 ). Stain with 4 %  uranyl acetate   for 2 min and  lead 
citrate   for 5 min [ 17 ].   

   11.    Examine the samples in a transmission electron  microscope  . For 
morphological analysis of  mitochondria   is recommended to cap-
ture digital images with a 16.500–20.000× magnifi cation.   

   12.    For  mitochondrial   ultrastructural analysis take 40–50 digital 
images per sample and evaluate membrane integrity of each 
mitochondrion by manually detecting structural abnormali-
ties.  Mitochondria   with an overall intact structure are consid-
ered healthy, but loss of membrane continuity is considered an 
index of disruption. The same approach is applicable to  cristae   
integrity analysis (Fig.  4 ).    

  Fig. 2    Images obtained from the mPTP live cell imaging assay. Neurons were loaded with the loading Mix, con-
taining calcein-AM, cobalt, and MitoTracker Orange. ( a ) Images show mitochondrial calcein fl uorescence dissipa-
tion on neurons exposed to 0.5 μM ionomycin which indicates mitochondrial permeability transition. Images 
show fl uorescence changes at the beginning ( t  = 0) and at the end ( t  = 600) of the experiment. ( b ) Images show 
the mitochondrial membrane potential loss in the same neuron shown in ( a ) under ionomycin stimulus       
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  Fig. 3    Slice preparation and treatment for electron microscopy. Incubation chamber is used to treat slices 
separately. Each well contains a cell strainer to keep the slices protected from bubbles generated by the oxy-
genation system. After the incubation time, the slices are immersed in fi xing solution, processed for electron 
microscopy and sequentially collected on copper grids for electron microscopy analysis. A representative 
image obtained with the microscope is shown at the end of the fl owchart       

  Fig. 4    Mitochondrial swelling detection by electron microscopy. Images show normal mitochondria with intact 
membrane and cristae ( left picture ) and a swollen mitochondrion ( right picture ) which is larger than normal 
and also displays membrane disruption and cristae disorganization, the common features of mitochondrial 
swelling by permeability transition. Bar = 500 nm       
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   13.    To evaluate  mitochondrial    swelling  , measure morphological 
parameters, such as  area  ,  diameter  , and  perimeter   [ 18 ] with 
 ImageJ software  . Set scale parameters in ImageJ: Analyze > Set 
scale > introduce distance in  pixels   and unit of length.  See  
 Note 13 .   

   14.    Set the parameters to be measured in ImageJ: Analyze > Set 
measurements > click in, Area, Perimeter and Feret’s  diameter  .   

   15.    Measure  mitochondrial    morphology   with the  polygon selec-
tion tool   of ImageJ by surrounding each mitochondrion and 
press Ctrl + M on the keyboard to display the Results win-
dow. Plot the results in a column graph and as a scatter plot 
graph to analyze the whole population of  mitochondria  .  See  
 Note 14 .       

4    Notes 

     1.    To maintain the  osmolarity   of the  Tyrode buffer   under calcium 
free conditions, add 3.997 g NaCl to the preparation instead 
3.944 g, to change the concentration from 135 to 136.8 mM 
NaCl.   

   2.    Glass  coverslips   of other diameters may be used depending on 
the chamber that is going to be mounted onto the  microscope   
stage for the  live cell assay  . Some microscopes have chamber 
adaptors for 12, 25, or 40 mm  diameter   coverslip. If the micro-
scope does not have chamber adaptors for different coverslip 
size, glass bottom dishes can also be used to seed cells.   

   3.    Try to load just one cover per assay to avoid  fl uorescence    decay   
during the time waiting between each experiment.   

   4.    Other MitoTracker stains could be used to evaluate the  mito-
chondrial    membrane    potential   during the  mPTP    live cell assay  , 
as  MitoTracker   Red CMXRos, but higher concentration of this 
probe is needed (between 200 and 1 μM). It is also important 
to check the  bleaching   of the probe depending on the  micro-
scope   available.   

   5.    Add 1 μL of 1 mM  Hoechst    33342   dye to 1 mL of  loading 
mix  . It is recommended to measure Hoechst stain only at the 
beginning and at the end of the experiment and not along it to 
avoid probes  bleaching  .   

   6.    If the cells were previously treated before the live imaging 
experiment, it is necessary to wash them to eliminate the  stim-
ulus  . Also it is important to wash the cells to deplete them 
from  B27  , since it could interfere with the stimulus that is 
going to be used for the  live cell assay  .   

   7.    Put the  paraffi n   only at the edges of the cover to maintain an 
adequate cellular fi eld to observe at the  microscope  . Some sys-
tems are magnetically sealed and do not need paraffi n.   
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   8.     Hoechst   λex/em = 350/461 nm. The ex/em peaks of  calcein   
after hydrolysis are 494/517 nm.  MitoTracker    Orange   λex/
em = 554/576 nm.   

   9.    For  live cell imaging  , the  stimulus   can be added manually with 
a  micropipette   or through a  peristaltic pump  .   

   10.    Use 0.5 μM of the ionophore  ionomycin  , as a positive control 
of  mitochondrial    permeability   transition. A loss of mitochon-
drial  calcein   is appreciated when this  stimulus   is added. As a 
negative control, incubate  neurons   for 30 min at 37 °C with 
20 μM  cyclosporin A   ( CsA  ) to inhibit  mPTP   opening before 
the stimulus. A control of probe  bleaching   is also needed. To 
evaluate this issue, measure the  fl uorescence   of the probe for 
the duration of the experiment by simply adding vehicle.   

   11.    An oxygenated  dish   can be manually made by introducing sili-
cone tubes adapted to a white pipette tip. Fix the tip to the 
inside wall of the dish until the middle of the well and connect 
the tube to the  oxygen  . Be sure to keep a constant oxygen fl ux 
along the experiment, avoiding bubbles directly on the slices. 
Mount the slices into a  cell strainer   (usually used for organo-
typic cultures) inside each dish. Under these conditions the 
slices can be maintained between 6 and 8 h without affecting 
cell  viability   ( see  Fig.  3 ).   

   12.    Prepare a fresh  fi xing solution   every time you need it and only 
the amount that is necessary for each experiment. Do not 
freeze.   

   13.    To determine distance in  pixels  , measure the length of the scale 
bar using the straight line selections tool of ImageJ and then 
open the set scale window and introduce the following param-
eters:  distance in pixels  is automatically determined by the soft-
ware when the scale bar is measured with the straight line tool; 
the  known distance  corresponds to the length of the scale bar 
measured from the image; and the  unit length  also depends on 
the scale bar unit usually in μm. Click on “Global”, and the 
fi nal scale should be in pixel/μm.   

   14.    The  scatter plot graphs   allow a deep analysis of the data, 
because they can be divided by  percentiles   to determine which 
population is affected by a determined treatment, as previously 
described ( see  [ 18 ]).         
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